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1 GENERAL INFORMATION 
 
 
1.1 DL Sm@rtSet™ DESCRIPTION 
 
DL Sm@rtSet™ is a powerful and versatile solution that allows an easy device set-
up. Extremely flexible, it guarantees the device configuration without reading from 
barcodes. 
 
Thanks to Datalogic research, a Remote System has been developed allowing the 
Datalogic device management through Internet or Intranet. Using this feature, you 
can modify the device configuration, update the software, send commands and 
activate a chat line with the remote operator, simply knowing the IP address of the 
computer to which the device is connected. 
 
DL Sm@rtSet™ offers a wide range of solutions to better satisfy any specific 
requirement from the user: 
• Automatic Detection of the connected device: DL Sm@rtSet™ can automatically 

identify the COM port where the device is connected to, the device model and its 
software release. See par. 2.2.2 for details. 

• Manual Selection of the device: the user can select the device to be configured 
from a series of images, representing all Datalogic products compatible with the 
program. This option, normally used with standard products, can also be used to 
prepare the configuration for devices not physically connected to the PC. At the 
end, the configuration can be printed, sent via e-mail or saved on the PC. See 
par. 4.1.2 for details. 

• Loading and saving configuration: the defined configuration can be saved in .xml 
format and recalled at any time. In this way, you can have a backup of the 
configuration of your devices and recall/modify it whenever needed. You can 
also send the configuration file via e-mail to be sure that all devices having a 
different location will be configured in the same way. See par. 4.1.3 for details. 

• Copy Mode: you can read the configuration parameters of a device and copy 
them to another device. See par. 4.3 for details. 

• Print Function: it offers the opportunity to print the barcodes of new parameters. 
This provides a method to configure the devices which are not connected to the 
PC. See par. 6.2.6 for details. 

• Software Upgrade: it allows upgrading the software of the device connected. 
See par. 4.2 and par. 5.2 for details. 

• Mailing: it permits sending configuration parameters by using an e-mail 
message. See par. 6.2.2. 
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• Remote Mode: it allows the remote control of the device via Internet or Intranet. 
Software configuration and software upgrade can be performed by simply 
connecting you computer (Client PC) to the IP address of the computer that the 
device is connected to (Server PC). See par. 2.2 for details. 

• Standard Windows graphic interface: DL Sm@rtSet™ does not require high 
programming skills. It is supported by an easy-to-use graphic interface, which 
offers a step-by-step approach to help you to create your own device 
configuration. 

 
 
1.2 COMPATIBLE PRODUCTS 
 
In the following list you find all Datalogic products which are compatible with  
DL Sm@rSet: 

• DL Cordless Card 

• DLC6065/90, DLC6165/90, DLC6265/90 

• DLC7070, DLC7072, DLC7075 

• DLD1000 

• DLL5010, DLL5110, DLL5510 

• DLL6010-M 

• DLL6010-R, OM6010-R 

• DLS2000 

• DRAGON™ D101 

• DRAGON™ M101, OM-DRAGON™ 

• GRYPHON™ D100/D110/D200 

• GRYPHON™ D120/D220 

• GRYPHON™ M100/M200 

• GRYPHON™ BT 

• OM-Gryphon™ 

• STAR Modem™ 

• TC1100 PDF, TC1100 Std 
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2 COMMUNICATING WITH DL Sm@rtSet™ 
 
 
Two different communication modes allow configuring a device by using  
DL Sm@rtSet™: 
 
Local Communication 
It sets a device connected to a local PC through an RS232 interface (see par. 2.1). 
 
Remote Communication 
It provides an online device set-up thanks to a connection between a Server PC and 
a Client PC based on Internet (through modem or proxy server) or Intranet  
(see par. 2.2). 
 
 
2.1 LOCAL COMMUNICATION 
 
A Datalogic device is connected through an RS232 serial interface to a local PC 
running DL Sm@rtSet™ in one of the following modes: 
• Serial Auto Detection (see par. 4.1.1) 
• Manual Selection (see par. 4.1.2) 
• Load From File (see par. 4.1.3) 
 
 
 

 
Figure 1 – Local Communication 

 
This connection offers different operations, such as: 
• Reading device configuration 
• Writing configuration 
• Software upgrading 
• Copy configuration 

Local PC 

RS232 interface cable
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2.2 REMOTE COMMUNICATION 
 
This communication occurs between a Server PC and a Client PC, where: 
 

- Server PC = physically connected to the device to be configured through the 
 serial interface, this PC must start DL Sm@rtSet™ in "Listen for  
 Connection" mode (see par. 5.1.1 for details) in order to wait for  
 the messages or commands sent by the Client PC. 

- Client PC = not necessarily connected to a device, this PC must start DL  
 Sm@rtSet™ in "Remote Connection" mode (see par. 5.1.2 for  
 details) in order to control the communication and act upon the  
 device connected to the Server PC. You may connect a device  
 to this PC in order to load the configuration of the remote  
 device and testing its functioning. 

 
For a correct communication functioning always keep in mind the following 
guidelines: 
 
1. Only if the “Enable Sm@rtSet Remoting” option has been disabled, available in 

the Options window, enable it again for both the Server and Client PCs, since it 
manages the remote properties activating this type of connection: 

 

 
Figure 2 – Enabling/Disabling Remote Connection 

 
 You can ignore this step in case this selection has never been changed, since it 

is enabled by default; 

2. Start DL Sm@rtSet™ on the Server PC in “Listening For Connection” mode to 
prepare it for receiving commands/messages from remote; 

3. Once the Server PC is in listening mode, activate the connection from the Client 
PC by using the desired type of remote connection. 

 
The remote connection between the two PCs can be activated in two different ways: 

• manually: this procedure can be used at any time, since the information required 
is to be inserted manually (see par. 2.2.1); 

• automatically: only after setting the Server PC by means of the register 
properties given in the Options window (available from the Tools 
menu), the communication can start automatically (see  
par. 2.2.2); 
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2.2.1 Manual Remote Communication 
 
A Datalogic device is connected to a Server PC running in “Listen For Connection” 
mode (see par. 5.1.1) and waiting for messages or commands to be sent by the 
Client PC via Internet/Intranet. The operator working with the Client PC may start the 
remote communication towards the Server PC in: 
- Peer-to-Peer mode 
- Web Server mode 
by manually inserting all information required (such as, IP address of Server PC and 
Web Server name). 
The available operations are listed in the following table: 
 

Peer-to-Peer Web Server 
Software Upgrade Configuration Transmission 

Configuration Transmission Single Command Transmission 
Single Command Transmission Chat 

Chat  
 
 
Peer-to-Peer Connection 
 
The Server and Client PCs are connected directly to Internet or Intranet. 
The Client PC can send single commands by using the chat feature (see par. 5.3 for 
details), a complete configuration, or a new software for the device upgrade. The 
Server PC immediately processes all these commands. 
Thanks to the chat line, the two operators (working with Client and Server PCs) can 
communicate exchanging messages. 
 

 
Figure 3 – Peer-to-Peer Connection 
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To communicate in Peer-to-Peer mode each element of the system must be 
configured as described below by following the given order.  
 

Server PC - physically connected to the device to be configured through 
RS232 serial interface 

- start DL Sm@rtSet™ in “Listen For Connection” mode 
- if necessary, send your IP address to the Client PC through the 

dialog presented by the program after startup (see par. 5.1.1) 
  

Client PC - start DL Sm@rtSet™ in “Remote Connection” mode 
- select the Peer-to-Peer connection mode and manually insert the 

IP address of the Server PC 
 

For more details about the selection of each option refer to chapter 5. 
 
 
Web Server Connection 
 
The Server PC is part of a LAN and has access to the Internet through a Proxy 
server. All Client PCs can communicate with the Server PC by means of a Web 
Server which belongs to the same LAN. 
To exploit this connection mode, the Web Server PC must be configured by installing 
the software module files contained in the ASP Extension directory provided in the 
program installation path (follow the instructions given in the “readme.txt” file for 
correct installation). 
During communication, the chat line is uni-directional and the Server PC can only 
receive messages. The Client PC can send commands and messages but it cannot 
upgrade the software on the device connected to the Server PC. 
 

 
Figure 4 – Web Server Connection 
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To communicate in Web Server mode each element of the system must be 
configured as described below by following the given order. 
 

Server PC - physically connected to the device to be configured through 
RS232 serial interface 

- start DL Sm@rtSet™ in “Listen For Connection” mode 
- if necessary, send your IP address to the Client PC through the 

dialog presented by the program after startup (see par. 5.1.1) 
  
Client PC - start DL Sm@rtSet™ in “Remote Connection” mode 

- select the Web Server connection mode and manually insert the 
IP address and the Web Server name (URL) of the Server PC 

 
For more details about the selection of each option refer to chapter 5. 
 
 
2.2.2 Automatic Remote Communication 
 
Datalogic S.p.A. provides a web service on its site through which the Server and 
Client PCs can exchange all information necessary to automatically start a remote 
communication. In particular: 
- Server PC: registers its data for remote identification; 
- Client PC: is in Server List mode and gets this data to automatically start the 

communication. 
 

 
Figure 5 – Server List Mode 
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Preliminary Settings on the Server PC 

To exploit this automatic connection the Server PC must be set as described in the 
following procedure. Its setting is to be performed in one of the following cases: 
- when communicating in Server List mode for the first time; 
- when changing the “Registering” information defined in a previous session. 

To set the Server PC proceed as follows: 
1. Start the program in offline mode by selecting the “Manual Selection” mode from 

the opening window, or by skipping it through the “Cancel” button; 
2. Open the Options window from the Tools menu and set the Server PC by means 

of the “Register Service” area available in the “Server Properties” folder: 
 

 
Figure 6 – Enabling/Disabling Remote Connection 

 
 Tick on the Registering check box. Then, you can define an Alias identifying the 

Server PC and insert its Web Server name (for ex. http://www.datalogic.com) if 
working in a LAN: 

 
Type of Connection Required Information 

Direct connection to Internet Alias 
Connection to Internet through a Web Server Alias + Web Server name 

 
3. Close the window and exit the program. The information defined is saved and 

maintained in the following sessions, until different data are inserted. 
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Server List 
 
The Server PC runs the program in “Listen For Connection” mode registering the 
information already defined in the Options window (see previous page for details). 
Once the registration has been successfully completed, the Client PC can connect to 
the Server PC according to the information registered.  
 

Registered Information (Server PC) Remote Connection Mode (Client PC) 
Alias Peer-to-Peer 

Alias + Web Server name Web Server 
 
All operations available depend on the connection mode adopted. 
 
To start the automatic connection, the system must be configured as described 
below by following the given order: 
 
Server PC - physically connected to the device to be configured through 

RS232 serial interface 
- start DL Sm@rtSet™ in “Listen For Connection” mode to register 

the information defined in the Options window (see previous page) 
  
Client PC - start DL Sm@rtSet™ in “Remote Connection” mode 

- choose the Server List mode and select the Server PC to 
automatically start the connection according to the information 
registered by the Server PC (see par. 5.1.2 under Server List). 
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2.3 TERMINOLOGY 
 
Local Communication a communication in which the device can be configured 

from a local PC. They are connected together through an 
RS232 serial interface. 

Remote Communication a communication in which the device connected to a PC 
through an RS232 serial interface is configured by a 
remote PC via Internet/Intranet. 

Server PC a PC connected to the device to be configured and 
running DL Sm@rtSet™ in “Listen For Connection” 
mode. It cannot act upon the connected device but only 
wait for messages or commands sent by a remote PC. 

Client PC a PC not necessarily connected to a device and running 
DL Sm@rtSet™ in “Remote Connection” mode. It 
communicates with the Server PC via Internet/Intranet 
controlling the device it is connected to. 

Web Server a PC controlling a local network (LAN) to which the 
Server PC belongs. 

Peer-to-Peer connection a direct connection between the Server and Client PCs 
via Internet. 

Web Server connection an Internet connection between the Server and Client 
PCs through a Web Server. 

Server List a Web service provided by Datalogic S.p.A. to simplify 
the remote communication and start an automatic 
connection between the Client and Server PCs. 
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3 INSTALLATION 
 
 
3.1 MINIMUM CONFIGURATION REQUIRED 
 
In order to install and use the DL Sm@rtSet™ software, it is necessary to have at 
least the following: 
- PC with a Pentium processor; 
- One of the following operating systems: 

Windows 95 
Windows 98 
Windows 2000 
Windows NT 
Windows XP 

- Free serial port; 
- 16 MB memory for Windows 95/98, 32 MB memory for Windows 2000/NT/XP; 
- Internet Explorer 4.01 at least for Windows 95; 
- hard disk with at least 1054 KB free space to run; 
- VGA video card or better. 
 
 
3.2 INSTALLING DL Sm@rtSet™ 
 
Two different versions of DL Sm@rtSet™ can be installed: 
• Free version available on the Datalogic web site and providing the local device 

configuration only; 
• Enterprise version available on the installation CD-ROM and providing both the 

local and remote configuration. 
 
Free Version 

This software version can be freely downloaded from the Datalogic web site after 
filling in the download form. 
Once the installation file has been launched, simply follow the suggestions given by a 
wizard to complete the operation. 
 
Enterprise Version 

This software version is available only on the installation CD-ROM. For a successful 
installation, follow the given steps: 
1. Insert the DL Sm@rtSet™ CD-ROM into the CD-ROM driver of your PC; 
2. Launch the Sm@rtSet™_Ent.exe file; 
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3. Follow the steps suggested by the installation wizard until the following dialog 
box appears: 

 
Figure 7 – Enterprise Installation 

 The “Server” and “Client” icons allow choosing the feature to be installed.  
 The “Server” one is always installed on your PC. If you want to install this feature 

only, it is necessary to disable the “Client” feature by means of the pull-down 
menu:  

 

 
Figure 8 – “Client” Pull-down Menu 

 
 This “Server” installation does not require any software authorization (see  

par. 3.3). 
  
 The “Client” feature is optional. If installed, at first program startup the License 

window appears requiring an authorization key to be assigned by Datalogic 
S.p.A. (see par. 3.3 for details). 

 
 If ignoring the selection of these features, both of them will be automatically 

installed allowing your PC to work either as a Server or as a Client according to 
your applications. 
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3.2.1 Utilities 
 
Once the installation has been completed, the following Utility Tools will be available 
in same installation directory containing DL Sm@rtSet™: 
 
• Device List Upgrade:  allows upgrading the DL Sm@rtSet™ device database 

by adding existing models loading a special software or 
a new software release (see par A.1 for details). 

• Downloader: is very useful when you need only to upgrade the 
software of a device (refer to par. A.2 for details). The 
same procedure may be performed using DL 
Sm@rtSet™ (see par. 4.2 and par. 5.2) but this choice is 
particularly advised when the device must also be 
configured. 

• On Line Upgrade: allows performing an on-line software upgrade of the  
DL Sm@rtSet™ program (see par. A.3 for details). 

 
 
3.3 AUTHORIZATION 
 
When running DL Sm@rtSet™ for the first time after a complete installation (both 
Server and Client features installed), the following window appears: 
 
 

 
Figure 9 - License Window 
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Licensed to 

It requires to type the user name. 
 
Key Number 

It is the authorization key the user must get from Datalogic S.p.A. by sending an  
e-mail request with the following information: 
 
- addressee = smartset@datalogic.it 

- subject field = authorization request 

- text body = authorization request 
Serial number: NNNNNNNNN 
PC Hardware number 

 
The Datalogic e-mail response will provide the authorization key (case sensitive) to 
be typed in the License window. 
 
Serial Number 

It is the number provided on the user's DL Sm@rtSet™ packaging. 
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4 DL Sm@rtSet™ LOCAL COMMUNICATION 
 
 
The local connection allows defining a device configuration when it is connected to 
the COM port of your Host PC through an RS 232 serial interface. 
 
 
4.1 DETECTION MODE 
 
Among all the detection modes listed within the starting window, the detection modes 
for local configuration are: 

• Serial Auto Detection 

• Manual Selection 

• Load From File 
 
 

 
Figure 10 - Starting DL Sm@rtSet™ 
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4.1.1 Serial Auto Detection 
 
The selection of this detection mode opens the following dialog box showing the 
COM port(s) available, their status and setting: 
 
 

 
Figure 11 - Auto Detection 

 
By clicking on the “Next” button the program automatically detects the COM port(s) 
available taking into account all possible values of the communication parameters. 
If you know the specific values of the COM port the device is connected to, click 
twice on the COM port to open a further dialog box where you can define the value of 
each communication parameter. 
 
Once the device is recognized, a dialog box appears reporting the serial port number 
the device is connected to, and other information about the device's name and its 
software release.  
 
Clicking again on the "Next" button opens another window displaying summary 
information about the system, where the "Read Configuration" check box allows 
getting the current device configuration.  
 
Finally, enter the configuration window by clicking on the “Finish” button. 
The desired device configuration can be defined by clicking on the parameter group 

available in the tree structure and clicking on the  icon. A secondary window 
appears displaying all the parameters to be set (see par. 6.1 for details). 
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4.1.2 Manual Selection 
 
The manual detect mode starts an offline configuration which can be saved to an 
.xml file, printed, sent in an e-mail message as an enclosed document, or sent to a 
connected device after performing the Synchronize operation (see par. 6.2.3). 
 
The selection of this detection mode activates a wizard allowing to choose the model 
of the device to be configured and its software release. 
Then, a final dialog box appears giving summary information about the system. 
Finally, enter the configuration window by clicking on the “Finish” button. The desired 
device configuration can be defined by clicking on the parameter group available in 

the tree structure and clicking on the  icon. A secondary window appears 
displaying all the parameters to be set (see par. 6.1 for details). 
 
After defining the parameter values, you can complete the configuration by: 

• Clicking on the  icon or selecting the Save/Save as option from the File 
menu to save the configuration to an .xml file; 

• Clicking on the  icon or selecting the Synchronize Device option from the 
Configuration menu to start the synchronize procedure and send the 
configuration to the connected device. This procedure requires that the 
connected device corresponds to the device model chosen for the configuration. 
If not, a message appears signaling the error and the configuration cannot be 
sent to the device; 

• Clicking on the  icon or selecting the Print option from the File menu to 
print the complete configuration and read the printed barcodes with the Datalogic 
device to be configured; 

• Clicking on the  icon or selecting the Send to option from the File menu to 
send the configuration as an .xml file enclosed in an e-mail message. 
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4.1.3 Loading Configuration from File 
 
The selection of this detection mode opens a dialog box to browse for an .xml 
configuration file previously saved.  
Then, a final dialog box appears giving summary information about the system. 
Finally, enter the configuration window by clicking on the “Finish” button. The desired 
device configuration can be defined by clicking on the parameter group available in 

the tree structure and clicking on the  icon. A secondary window appears 
displaying all the parameters to be set (see par. 6.1 for details). 
 
After defining the parameter values, you can complete the configuration by: 

• Clicking on the  icon or selecting the Save/Save as option from the File 
menu to save the configuration to an .xml file; 

• Clicking on the  icon or selecting the Synchronize Device option from the 
Configuration menu to start the synchronize procedure and send the 
configuration to the connected device. This procedure requires that the 
connected device corresponds to the device model chosen for the configuration. 
If not, a message appears signaling the error and the configuration cannot be 
sent to the device. 

• Clicking on the  icon or selecting the Print option from the File menu to 
print the complete configuration and configure the device by reading the printed 
barcodes; 

• Clicking on the  icon or selecting the Send to option from the File menu to 
send the configuration as an .xml file enclosed in an e-mail message. 
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4.2 SOFTWARE UPGRADE 
 
This operation can be performed when a device is connected to the program. For this 
reason, when working in “Manual” or “Load from File” mode, it is necessary to 
perform the synchronize procedure to start the transmission between the program 
and the device itself. 

Clicking on the  icon opens an optional area in the bottom part of the main 
window allowing to select a .HEX file and download it onto the connected device: 
 
 

 
Figure 12 – Downloading Area 

 
The successful downloading will be signaled by an acoustic signal emitted from the 
device and a message displayed by the program. 
 
 

 
NOTE 

Some devices require being reset to complete this operation. 
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4.3 COPY CONFIGURATION 
 
This feature allows copying the configuration of a device to another one of the same 
model and loading the same software release. To perform this operation the system 
requires that more than one device is connected to the same PC by means of one or 
more COM ports. 
 
 

 
Figure 13 – Copy Command 

 

First, click on the  icon to get the configuration of the device (ex. Reader 1) to 
which the program is connected.  

Then, click on the  icon and a dialog box appears displaying the COM port(s) 
available on your PC 

- if working with only one COM port, substitute the device (ex. Reader 1) with the 
one to be configured (ex. Reader 2), then click on the “Next” button to send it the 
copied configuration; 

- if working with more than one COM port, select the COM port to which the 
device to be configured (ex. Reader 2) is connected and click on the “Next” 
button to send it the copied configuration. 

 
Once the configuration has been copied, a final dialog box reports information about 
the procedure and lists all copied command strings. 
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5 DL Sm@rtSet™ REMOTE COMMUNICATION 
 
 
The remote configuration allows configuring a device connected to a Server PC from 
a Client PC. 
 
 
5.1 DETECTION MODE 
 
Among all the detection modes listed within the starting window, the detection modes 
for remote configuration are: 

• Listen For Connection 

• Remote Connection 
 
 

 
Figure 14 - Starting DL Sm@rtSet™ 
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5.1.1 Listening for Connection – Server PC 
 
This detect mode requires a device to be connected to the Host PC serial port and 
causes the PC to work as a Server (see par. 2.1). 
By selecting this detect mode, first an autodetect procedure is activated to search for 
the connected device. Then, a dialog box appears giving summary information about 
the system before displaying the configuration window which shows the current 
device configuration (see par. 6.1 for details). 
The display of the configuration window is preceded by the following dialog box, only 
when the Server PC has not registered its alias or web server name (see par. 2.2.2). 
This dialog box asks to send an e-mail message containing your computer IP 
Address: 
 
 

 
Figure 15 - Sending E-mail with IP Address 

 
If accepting, the Mail window is opened reporting the IP address value in the subject 
field and allowing to write a message (see par. 6.2.2). This feature is very useful 
when working in Manual Remote Configuration, because it allows communicating the 
IP address to the Client PC to be connected to. 
This dialog box does not appear when the Server PC registration occurs, since all 
information is automatically provided to the Client PC. 
 
When working in this mode it is not possible to act upon the connected device, since 
the Server PC waits for commands, configuration, messages or software upgrades 
sent by the Client. 

Only by clicking on the  icon (refer to par. 6.1.2 ), this state is interrupted and the 
device configuration can be modified in local communication. 
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5.1.2 Remote Connection – Client PC 
 
This detect mode causes the PC to work as a Client PC controlling the device 
connected to the Server PC (see par. 2.2). 
By selecting this detect mode the following dialog box appears: 
 
 

 
Figure 16 - Choosing Remote Communication 

 
Three different possibilities are available to start the remote connection: 

• Peer-to-Peer 

• Web Server 

• Server List 
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Peer-to-Peer 
 
The Peer-to-Peer connection requires defining the IP address of the Server PC (see 
par. 2.2.1 under Peer-to-Peer Connection). 
You can select it from the pull-down list available in the “Remote address” area. This 
list reports only the IP addresses already registered in the Address Book (see par. 
6.2.5). 
 
Otherwise, the IP address can be inserted by ticking the “Advanced settings” check 
box and clicking on the “Next” button. 
The following window appears allowing to insert the IP address of the Server PC or 
its DNS address: 
 
 

 
Figure 17 – Peer-to-Peer 

 
After inserting the IP address, click on the "Next" button to start the remote 
connection. 
If successful, a final dialog box appears giving summary information about the 
system. 
Finally, enter the configuration window by clicking on the “Finish” button. The desired 
device configuration can be defined by clicking on the parameter group available in 

the tree structure and clicking on the  icon. A secondary window appears 
displaying all the parameters to be set (see par. 6.1 for details). 
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Web Server 
 
The Web Server connection requires defining the IP address and the Web Server 
name of the Server PC (see par. 2.2.1 under Web Server Connection). 
To start this connection select the user name from the pull-down list available in the 
“Remote address” area, whose Web Server name has already been defined in the 
Address Book (see par. 6.2.5). 
The Web Server can also be defined by ticking the “Advanced settings” check box 
and clicking on the “Next” button. 
The following window appears allowing to insert the IP address of the Server PC and 
the DNS Address (URL): 
 
 

 
Figure 18 – Web Server 

 
After inserting the IP and DNS addresses, click on the "Next" button to start the 
remote connection. If successful, a final dialog box appears giving summary 
information about the system. 
Finally, enter the configuration window by clicking on the “Finish” button. The desired 
device configuration can be defined by clicking on the parameter group available in 

the tree structure and clicking on the  icon. A secondary window appears 
displaying all the parameters to be set (see par. 6.1 for details). 
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Server List 
 
The Server List connection only requires the selection of the Server PC. Then, the 
remote connection is started automatically (see par. 2.2.2). 
 
To start the connection click on the “Next” button to display the following dialog box 
listing all server PCs registered within the system.  

The  icon signals that the Server PC is not available at that moment. 
 

 
Figure 19 – Server List 

 
After selecting the desired Server PC, click on the “Next” button to start the 
connection. Depending on the information registered by the Server PC (Alias, Web 
Server name) the connection will be started in Peer-to-Peer or Web Server mode 
(see par. 2.2.2 under Server List). Once the connection has been completed 
successfully, a final dialog box appears giving summary information about the 
system. 
 
Finally, enter the configuration window by clicking on the “Finish” button. The desired 
device configuration can be defined by clicking on the parameter group available in 

the tree structure and clicking on the  icon. A secondary window appears 
displaying all the parameters to be set (see par. 6.1 for details). 
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5.2 SOFTWARE UPGRADE 
 
This operation is performed only by the Client PC when connected in Peer-to-Peer 
mode (or in Server List mode working as Peer-to-Peer). 

Clicking on the  icon opens a dialog box allowing to search for the .HEX file to 
be transferred to the Server PC. Once the file has been transferred, it is automatically 
loaded onto the device. The successful downloading will be signaled by an acoustic 
signal emitted from the device and information about the procedure reported in the 
bottom part of the Server PC main window: 
 
 

 
Figure 20 - Server PC Optional Areas 

 
The downloading area reports the path used to position the downloading temporary 
file. 
 

 
NOTE 

Some devices require being reset to complete this operation. 

 
 
5.3 CHAT 
 
This feature is performed by both Client and Server PCs if working in Peer-to-Peer 
connection mode. In case of Web Server connection mode, it is only the Client PC 
which can send messages/commands to the Server PC. 

By clicking on the  icon the following area is displayed in the bottom part of the 
window: 
 
 

 
Figure 21 - Chat Feature from Server in Peer-to-Peer 
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Figure 22 - Chat Feature from Client PC 

 
The upper part of this area reports information about all received/sent messages 
during communication and it cannot be modified.  
The lower part is the input area for typing a message or the string of the command to 
be sent to the device.  

Click on the  icon or on the  icon to send a message or a command 
string respectively. 
After transmission, the message will be reported in the upper part of the chat area of 
the PC. If sending a command string, its correct transmission will also be signaled by 
the device beeper. 
 
 
5.4 APPLICATION EXAMPLE 
 
The following example shows how the remote communication in Peer-to-Peer mode 
can be exploited to define the same configuration for all the devices present in the 
system. 
The Client PC communicates with each Server PC through the Internet or Intranet 
and can control each device connected. 
 
 

 
Figure 23 – Example of Peer-to-Peer Connection 
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6 DL Sm@rtSet™ FUNCTIONING 
 
 
6.1 DL Sm@rtSet™ CONFIGURATION WINDOW OVERVIEW 
 
The configuration window provides all the parameters to be set when configuring the 
device. The following image gives an example of the configuration window, since the 
display of the optional area depends on the detect mode the system is working with: 
 
 

 
 
 
 

Figure 24 - Configuration Window Example 
 
The left side of the window displays a tree structure providing all the configurable 
parameters, while the right side works as a display showing the value of the 
parameters belonging to the selected group. 
 
To change the parameter value it is necessary to click on the parameter group and 

then on the  icon (see par. 6.1.2 for details). A secondary window appears 
displaying all parameters to be set. 
 
 
 

Tool bar 

Display 
area 

Optional 
area 

Status bar 

Tree 
structure 

Menu bar 
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The optional area is displayed in the bottom part of the window when: 

- changing parameter values (report area); 

- downloading the software upgrade from either remote or local PC (downloading 
area); 

- sending commands/messages from the Client PC to the Server PC during 
remote configuration (chat area); 

- starting “Listen for Connection” mode during remote configuration (logging 
area). 

 
The report area (see Figure 25) appears when configuring the device from a local 
PC (see Chapter 4). 
 
The downloading area appears when sending the software upgrade file from either 
a local PC or a remote one. The following image gives an example when working 
with a local PC: 
 
 

 
Figure 25 - Optional Areas in Local Communication 

 

Downloading 
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Report
area
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The logging and chat areas are displayed only when working in remote connection 
and appear like in the following example: 
 
 

 
Figure 26 - Optional Areas in Remote Communication 

 
The display of all optional areas can be managed by using the corresponding icons 
(see par. 6.1.2 for details): 
 

 
= report area 

= downloading area in local communication 
 

 = downloading area in remote communication 

 
= chat area 

 
= logging area 

Logging
area

Chat
area

Downloading 
area 
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6.1.1 Menu Bar 
 
The menu bar provides the major functions managing the system communication. 
Select the desired option from the menu by clicking on it within the pull-down list. 
 
 File Menu 

The File Menu manages the following options: 
 
New Reader  = allows starting a new configuration. 
Save, Save As  = saves the current file or saves a copy of it with a different  

 name. Configuration files share the extension *.xml. 
Send To  = opens the mail window (see par. 6.2.2). 
Print  = opens a window giving an overview of the codes to be printed 

 (see par. 6.2.3 for details) 
Print Setup  = sets the printer properties. 
Exit  = exits DL Sm@rtSet™. 

 
 
 Actions Menu 

The Actions Menu manages the following options: 
 
Properties  = if selected after clicking on the desired parameter group, it 

 opens a secondary window to set the parameter values. 
Show Report = opens a report area in the bottom part of the window 

 showing all the changed parameters and their old and 
 new values. 

Show Changes  = shows the changed parameter by highlighting in blue its 
 new values. 

Show Default  = highlights in green the configuration parameters having a  
 value different from the default one. 

Show Target  = if selecting a changed parameter within the report area, it  
 highlights the parameter group position within the tree  
 structure. 

Undo  = deletes the operation selected from the report area  
 available in the bottom part of the window. 

Stop Listening  = stops the "Listen for Connection" mode during remote 
 configuration (see par. 5.1.1 for details). 

Show Remote Log  = opens a logging area showing all the commands received 
 from the Client PC during the remote configuration.  

Show Remote Chat  = opens a chat area showing all the messages sent  
 between the Client and Server PCs during the 
 remote configuration (see par. 5.3). 
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 Configuration Menu 
The Configuration Menu manages the following options: 
 
Read Configuration  = Gets the device current configuration through the PC 

 serial port 
Write Configuration  = sends the complete configuration to the connected device 

 via serial interface. 
Synchronize Device  = opens the synchronize window (see par. 6.2.3). 
Write to Remote  = sends the complete configuration to the device connected 

 to the Server PC during the remote configuration. 
Restore Default  = Restores the device default configuration 
Save to RAM  = Saves the configuration file to the device temporary 

 memory (RAM) 
Save to EEPROM  = Saves the configuration file to the device permanent 

 memory (EEPROM) 
 
 
 Tools Menu 

The Tools Menu manages the following options: 
 
Activate Terminal  = if the device is connected to a free serial port through an 

 RS232 interface, this command activates a device 
 terminal window showing the barcodes the device is 
 reading (see par. 6.2.4 for details). 

Download Firmware  = opens a downloading area allowing to search for the 
 software upgrade file to be sent to the device and to log 
 the downloading procedure in local communication (see 
 par. 4.2). 

Download Remote 
Firmware 

 = opens a dialog box allowing to search for the software 
 upgrade file to be sent to the device connected to the  
 Server PC. After the file transferring, a downloading area 
  appears on the Server PC logging the downloading  
 procedure (see par. 5.2 for details). 

Address Book  = opens a dialog box managing a personalized address 
 book (see par. 6.2.5 for details). 

Options  = opens a dialog box managing the Server properties and 
 graphical user interface in the program (GUI). See  
 par. 6.2.1. 
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 Help Menu 
The Help Menu manages the following options: 
 
Contents F1  = provides the topic structure in an active outline form 

 making the topic search easier and supplying the 
 relative information. 

About  = provides information about the software version. 
http://www.datalogic.com  = connects to Datalogic web site. 

 
 
6.1.2 Tool Bar and Status Bar 
 
The icons available on the Tool bar have the following function: 
 

 
 = Opens the starting dialog box to configure a new device. 

 
 = Saves the current configuration with a different name. Configuration 
 files share the *.xml. extension. 

 
 = opens a window allowing to send an e-mail message enclosing an .xml 
 configuration file (see par. 6.2.2). 

 
 = opens a window providing an overview of the barcodes to be printed 
 (see par. 6.2.3 for details). 

 
 = saves the current configuration on the device RAM. 

 
 = saves the current configuration on the device EEPROM. 

 
 = restores the default configuration. 

 
 = opens a dialog box to define the values of the selected group of 
 parameters. 

 
 = opens the terminal emulator (see par. 6.2.4 for details). 

 
= gets the current device configuration via serial interface. 

 
 = sends the complete configuration to the device via serial interface. 
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 = opens the synchronize window (see par. 6.2.3). 

 
 = opens the Address Book window (see par. 6.2.5 for details). 

 
 = sends the complete configuration to the device connected to the Server 
 PC during the remote configuration (see chapter 5 for details) 

 
 = stops the remote communication of the Server PC. 

 
 = opens DL Sm@rtSet™ help on-line. 

 
 = deletes the operation selected from the report area available in the 
 bottom part of the window. 

 
 = if selecting a changed parameter within the report area, it highlights the 
 parameter group position within the tree structure. 

 
 = shows the changed parameter by highlighting in blue its new values. 

 
 = opens/closes report area in the bottom part of the window showing all 
 the changed parameters and their old and new values. 

 
 = highlights in green the configuration parameters having a value different 
 from the default one. 

 

 = opens/closes a logging area in the bottom part of the window showing 
 all the commands received from the Client PC during the remote 
 configuration. 

 

 = opens/closes a chat area in the bottom part of the window showing all 
 the messages sent between the Client and Server PCs during 
 the remote configuration (see par. 5.3 for details). 

 
 = starts the downloading procedure by sending the software upgrade to 
 the device from the local PC. 

 
 = starts the remote downloading procedure by sending the software 
upgrade file to the device connected to the Server PC from the Client PC. 

 
The Status bar provides further information about the communication parameters of 
the current connection (device/PC) on the right side, while on the left side it is 
possible to get a short help about the menu options, if selected, or about the 
command activating the help on-line. 
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6.2 DL Sm@rtSet™ SECONDARY WINDOWS 
 
Secondary windows are provided for a better management of the following functions: 
- Options 
- Mail 
- Device Synchronization 
- Terminal Emulator 
- Address Book 
- Print 
 
 
6.2.1 Options Window 
 
By selecting "Options" from the Tools menu the following window appears: 
 
 

 
Figure 27 - GUI Properties 

 
The "GUI Properties" folder allows enabling/disabling the management of the 
graphical user interface (GUI), that is of interactive buttons or scroll bars. 
The program must be restarted to activate the selection. It is also possible to adopt 
the XP menu style and to define a new color to signal changed items, and values 
different from the default ones. 
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The "Server Properties" folder is fundamental for managing the program remote 
properties: 
 
 

 
Figure 28 - Server Properties 

 
The “Server Properties” area enables/disables the remote communication (see  
par. 2.2). 
 
The “Register Service” area is to be defined when starting a remote communication 
in Server List mode (see par. 2.2.2). 
 
The “Mailing Service” area manages the dialog box displayed when connecting in 
“Listening for Connection” during the remote connection (see par. 5.1.1). This option 
is automatically disabled when defining and registering the information in the 
“Register Service” area. 
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6.2.2 Mail Window 
 

When clicking on the  icon or selecting the "Send to" option from the File Menu, 
the following dialog box appears: 
 
 

 
Figure 29 - Mail Window 

 
It always sends the current configuration as an enclosed .xml file document. In 
addition, it allows sending written text to the desired addressee as in a typical 
Microsoft Office mail message. 
 
Once the message has been sent, a dialog box will appear reporting the transmission 
result. 
 
 
6.2.3 Synchronize Window 
 
When working in offline mode (“Manual selection”, or “Load from File”), it is possible 
to synchronize the selected device to the connected one. If the connected device 
corresponds to the device model selected for the configuration, it is possible to send 
it the defined configuration. 

By clicking on the  icon or selecting the "Synchronize Device" option from the 
configuration menu, the following dialog box appears: 
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Figure 30 - Synchronize Window 

 

This procedure starts by clicking on the  icon; then, different messages will 
be displayed depending on the right or wrong device synchronization. 
 
 
6.2.4 Terminal Emulator 
 

The terminal emulator appears when clicking on the  icon or selecting the 
"Activate Reader Terminal" option from the Tools menu: 
 

 
Figure 31 - Terminal Emulator 

 
It allows testing the device functioning while reading barcodes. 
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6.2.5 Address Book Window 
 

The Address Book window appears by clicking on the  icon or selecting the 
"Address Book" option from the Tools menu: 
 
 

 
Figure 32 - Address Book Window 

 

 

= adds a new user name to the list and to define details by means of the 
 dialog box displayed below. 

 
= deletes the selected name from the list. 

 

= opens the following dialog box allowing to get more details about the  
 user or to modify them. 

 
All users registered will be listed in the “Remote Address” area when starting a  
Peer-to-Peer or a Web Server connection mode (see par. 5.1.2 for details). 
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Figure 33 - Adding New User 

 
Fill in the “Internet address” edit box with the Web Server name. Insert the computer 
IP address in the “Machine address” edit box.  
Then, click on the "Add" button and then on the "OK" button to add a new user name 
to the list. 
 
 
6.2.6 Print Window 
 

The Print window appears when clicking on the  icon or selecting the "Print" 
option from the File menu: 
 

 
Figure 34 - Print Window 

 
The commands are printed with the corresponding barcodes and strings. 
If the device connected to the PC is a slot device, the print will automatically be 
executed on the border of the pages. 
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7 TROUBLESHOOTING 
 
 
Auto(detect) mode: in case some problems arise during the detect procedure and 

no device is found ensure the connection cable has been 
inserted correctly. 

Downloading 
Procedure: 

if the .hex software upgrading file is not loaded onto the 
device, check if the downloading optional area displays the 
following message: 
"Device not responding. Reset the device please". 
This means your device needs to be reset to cause the 
upgrade to be uploaded. 

Remote 
Connection: 

if you are not allowed to start the connection as a Server or 
Client PC, verify that the Server Properties within the Options 
window have been enabled (see par. 6.2.1). 

Server List 
Connection 

if the connection through the Server List fails, verify that the 
Server PC alias and/or Web Server name have been 
registered correctly. 
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A DL SM@RTSET™ UTILITY TOOLS 
 
Three different utility tools are available when installing DL Sm@rtSet™: 
- Device List Upgrade 
- Downloader 
- On Line Upgrade 
 
 
A.1 DEVICE LIST UPGRADE 
 
When starting a communication, DL Sm@rtSet™ always verifies that the connected 
device is compatible with one of those listed in the program database. The devices 
with a special software or a new software release may not satisfy this compatibility, 
since they are not listed in the DL Sm@rtSet™ database. The Device List Upgrade 
utility tool is intended to upgrade the program database by adding the incompatible 
products. In particular, it allows defining a compatibility between a device already 
existing in the DL Sm@rtSet™ database and the one to be added. 
 
 

 
CAUTION 

Contact your Datalogic local distributor to get information about the 
compatibility between your device and a device already existing in 
the DL Sm@rtSet™ database. Defining a wrong compatibility may 
cause errors and an unpredictable behavior of DL Sm@rtSet™. 

 
 
When starting the utility, the following dialog box appears warning the user to set the 
device communication parameters to their default values. If the communication 
parameters are set differently, it will not be possible to proceed with the upgrading 
procedure: 
 
 

 
Figure 35 – Warning Message 
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After a right configuration of the communication parameters, the utility starting 
window appears as follows:  
 

 
Figure 36 – Starting Device List Upgrade 

 
From the list of the available serial ports select (check) the one the device is 
connected to. Then, press the “Next” button to start an automatic detection of the 
selected COM ports. 

If the device software is already present in the DL Sm@rtSet™ database, a warning 
message appears and the DL Sm@rtSet™ database will be not upgraded. 

If the device loads a special software or a new software release not present in the 
database, the following window is displayed: 
 

 
Figure 37 – New Device Found 
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By pressing the “Next” button it is possible to add the device. 
The following window appears listing all the device models, and the related software 
release, configurable in DL Sm@rtSet™. By scrolling this list, select the model which 
is compatible with the device to be added. Then, click on the “Finish” button to 
complete the upgrade. 
 

 
Figure 38 – Adding a New Device 

 
 
A.2 DOWNLOADER 
 
DL Sm@rtSet™ Downloader tool allows upgrading the firmware of the device 
connected to the Host PC. In particular, an upgrading .hex file has to be downloaded 
onto the device. 
 
The Downloader is very useful for upgrading in a very simple and fast way the 
software of a device.  
In case the device needs to be configured and updated, it is advised to complete 
both operations through DL Sm@rtSet™ ( see par. 4.2 and 5.2). 
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When starting the utility the following window appears: 
 

 
Figure 39 – Downloader Starting Window 

 
 
It is possible to browse for the upgrading .hex/.bin file in the dialog box displayed by 

clicking on the  button or by selecting the Open option from the File menu. 
Once the file has been selected, it will be displayed in the “Selected File” edit box. 

Then, it can be downloaded onto the connected device by clicking on the  
button or by selecting the Download option from the Action menu. 
The downloading procedure can be stopped at anytime by clicking on the 

 button. 
 
 

 
NOTE 

To upgrade a USB device, start the program; then, reset and connect 
the device to the USB port by keeping the device trigger pressed. 
The program will open a dialog box reporting the name of the 
connected USB device and allowing to stop the connection or 
continue with the program download. 
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A.2.1 Communication Settings 
 
The communication parameter values can be changed according to your system 
settings by selecting the COM Interface option from the Actions menu: 
 

 
Figure 40 – Communication Settings 

 
Through the two edit boxes it is possible to set the COM port, to which the device to 
be upgraded is connected, and the transmission speed (baud rate). 
Once the desired values have been defined, click on the “OK” button to enter the 
main window again. Then, it is possible to start the downloading procedure. 
 
 
A.2.2 Help 
 
If more information about the firmware upgrade procedure is required, it is available 
in the window displayed by selecting the More Info option from the Help menu: 
 

 
Figure 41 – Help Window 



DL Sm@rtSet™ 

48 
 

A A 

A.3 ON LINE UPGRADE 
 
The On Line Upgrade tool allows upgrading the DL Sm@rtSet™ application by 
downloading the last version of its components on line. This procedure exploits the 
same web service provided by Datalogic on its site and used for the Server List 
connection (see par. 2.2.2 for details). 
 
When starting the utility the following window appears: 
 
 

 
Figure 42 – On Line Upgrade 

 
To start the On Line Upgrade, first click on the “Check” button. The utility connects to 
the Datalogic web service searching for a new version of the DL Sm@rtSet™ 
software components. 
If the upgrade is available, the following window appears: 
 
 

 
Figure 43 – Upgrading DL Sm@rtSet™ 
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By clicking the “Details” button the following window is displayed reporting the status 
of all the DL Sm@rtSet™ files: 
 
 

 
Figure 44 – DL Sm@rtSet™ File List 

 
For each file is available its current, newest and previous version. 
 
By clicking on the “Update” button, the upgrading procedure starts by downloading 
the new files and recovering the old ones in a backup directory. 
 
In case one or more files will be not upgraded correctly, it is possible to restore their 
previous version by clicking on the “Restore” button. 
 
 

 
NOTE 

Both the Upgrade and Restore procedures involves all files. For this 
reason, it is not possible to upgrade or restore a single file. 
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